AUTHOR CONTRACTS FOR TYPESETTING
TYPESET MANUSCRIPT PREPARATION GUIDE
ROWMAN & LITTLEFIELD PUBLISHING GROUP

Rowman & Littlefield - Lexington Books : Jason Aronson

The Rowman & Littlefield Publishing Group (RLPG) uses the Chicago Manual of Style, 15th ed., and Merriam-
Webster’s Collegiate Dictionary, 11th ed., as style and spelling guides. We encourage you to do the same. If your
manuscript follows a different style guide, please consult with your acquisitions editor.

Please read through these guidelines in full. Your manuscript should conform as closely as possible to these
guidelines, or it may be returned to you for revision. If you have questions, please contact your acquisitions
editor.

SOFTWARE
We accept Microsoft Word files in both PC and Mac formats. If you used WordPerfect or some other software,
you must convert your files to Word before submitting them to your acquisitions editor. Please review your files
to make sure that no errors were caused by the conversion. We request that editors of collective works submit all
parts of their book in the same word processing program.

PERMISSIONS
It is the author’s responsibility to obtain written permission from the copyright holder and to pay to reproduce
copyrighted material, including music lyrics, poetry, artwork, and previously published works. Permission from
the author will only be sufficient if full rights of publication have been reverted to that author, in writing, by the
original publisher.

If you are working on a revised edition for which items in the previous edition required permission, you must re-
obtain permission for those items.

You must provide RLPG with the original, signed permissions and the source credit line that we are required to
include in the published book. For more on copyright and permissions and sample permissions letters, refer to
the RLPG Permissions Guide.

PREPARING YOUR MANUSCRIPT
During the typesetting process, we will format the text into book pages. In order for typesetting to be as trouble-
free as possible, it is imperative that you format your manuscript as follows:

e Use 12-point Times or Times Roman for all text (including subheadings, quotes, notes, and bibliography).

e Pages should be double-spaced with one-inch margins (including the notes and bibliography).

e Save each chapter and parts page in its own file. File names should be easily recognized, for example,
contents.doc, intro.doc, ch01.doc, biblio.doc.

* DPlease number pages sequentially throughout the manuscript (do not begin each chapter with page 1). This
will save us an enormous amount of trouble. You can change the page number a file begins on using the
Insert->Page Numbers->Format box.

*  Quotes of five or more lines should be extracted and indented one-half inch from the left margin.

e Do not use the space bar to indent the first line of a paragraph. Use a tab, preferably, or Word’s indent
feature.

¢ Do not insert a blank line between paragraphs. If you need to indicate a change of subject without using a
subhead, type ”"<break>" on a line by itself (so we know you intended to have a blank line), but keep these to
a minimum.
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e If you copied and pasted text from, for example, an e-mail or a PDF, remove mid-sentence hard or soft
returns.

¢ Do not use hyphens to break words at the ends of lines; let lines wrap naturally. Turn off the hyphenation
feature of your software.

e  Use italics for emphasis.

¢ Do not use underlining.

e Text should be left-justified, not fully justified. (Full justification hides spacing problems.)

¢ Do not change font sizes or styles throughout the manuscript. Stick to a Times Roman font, even for
subheadings.

e Prepare a table of contents: list all parts/sections; chapter numbers, titles, and subtitles;
bibliography/references; and authors (if an edited collection). We use your contents to verify that we have all
parts of your manuscript, so be sure it is complete. For page numbers in the table of contents, type 000 (page
numbers will change in typesetting).

e Leave no comments, tracked changes, highlighting, or hidden text in the final version of the manuscript.

CHAPTER TITLES AND SUBHEADINGS

e Chapter titles, subtitles, and subheadings should be brief but meaningful.

¢ Do not place note numbers on chapter titles, subtitles, author names, or subheads.

e Subheads should not be numbers only. If you would like to use an outline format, check with your
acquisitions editor first.

e Set each subheading on its own line.

e Avoid starting a chapter with a subhead, especially “introduction.”

e If youneed to indicate a change of subject without using a subhead, type “<break>" on a line by itself (so we
know you intended to have a blank line), but keep these to a minimum.

e Subheadings are used to make your organization clear to your readers; there should be no need for more than
three levels of subheads, and you may not have that many, or any at all, depending on the type of book
(textbooks must have subheadings). Type subheadings as follows:

1. First- or A-level subheads: center the text and type in upper- and lowercase:
This Is How an A-level Subhead Should Appear in Your Manuscript

2. Second- or B-level subheads: set the text flush left and type in upper- and lowercase:
This Is How a B-level Subhead Should Appear in Your Manuscript

3. Third- or C-level subheads: set the text flush left, italicized, and type in upper- and lowercase:
This Is How a C-level Subhead Should Appear in Your Manuscript

e Itis okay for a subheading to be the last line on a manuscript page—this will be adjusted in typesetting.

e Subheadings are capitalized the same way book titles are: The first and last words are always capitalized, as
are all other words except articles (the, an, etc.), prepositions (through, in, etc.), and coordinating conjunctions
(and, or, etc.).

CITATIONS AND DOCUMENTATION
RLPG accepts two citation styles: notes plus bibliography (humanities) and author-date. If you wish to use an
alternate style (e.g., AAA, APA), first get approval from your acquisitions editor. APA style is acceptable for
Jason Aronson authors. All chapters in your book must use the same citation style (unless it consists of previously
published material).

For samples of acceptable formatting, refer to http://www.chicagomanualofstyle.org/tools citationguide.html.
For anything not covered there, refer to the Chicago Manual of Style, 15th ed., chapters 16 and 17.
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Truncating Page Numbers
Truncate cited page numbers in the following style: There is no truncation for single- and double-digit numbers
plus multiples of 100 (e.g., 1-5, 10-11, 15-19, 100-101, 300-310); keep the last digit for numbers 101 through 109
[and multiples thereof] (e.g., 105-9, 203—4) and for three or more digits (e.g., 14748, 2257-63).

Endnotes versus Footnotes
RLPG publishes all books with endnotes, not footnotes. If you prepared your manuscript with footnotes, please
convert them to endnotes before the final submission. You can do this using the
Insert->Reference->Footnote->Convert box.

ABOUT THE AUTHOR(S)/CONTRIBUTORS
RLPG books include mini-biographies (i.e., About the Authors or About the Contributors) at the end of each
book. These should be fairly short—usually one or two paragraphs per author—and include both academic and
professional accomplishments. Samples are available from your acquisitions editor.

TABLES AND TEXTBOXES/SIDEBARS
If you have tables in your book, refer to the RLPG Tables Guide. We will import all of your manuscript files
(especially tables) into our typesetting software, which allows us to avoid rekeying and thus typos, so it is
important that you follow these guidelines.

* Use Word'’s tables feature to produce tables; this will ensure proper column/row alignment. Do not use tabs
or spaces, which cause alignment problems.

¢ Do not use spreadsheet software (e.g., Excel) to create tables.

¢ Include captions and sources (if any) on all of your tables and textboxes.

e Textboxes should be typed just like regular text, without boxes, rules, or shading.

¢ Double-number your tables and textboxes so the first number is the chapter number and the second number
indicates the sequence (e.g., table 2.3 is the third table in chapter 2).

e Save tables and textboxes one per file, named for the item (e.g., “box3.1.doc”). Do not place tables or textboxes
in the chapter files. Use callouts (see below).

¢ Direct your readers to your tables and textboxes by referring to them in the text by number (e.g., “table 3.3
shows . ..” or “see box 3.1”).

¢ Place callouts near where you would like tables and textboxes to appear (e.g., <table 3.3 near here>).

e Tables and textboxes will be placed as near their callouts as text allows, but that is not determined until
typesetting, so do not refer to tables and textboxes as being “above,” “below,” or on a specific page.

¢ If you would like your book to have a list of tables in the front matter, you must include it in the manuscript.

ARTWORK
Submit all artwork to your acquisitions editor for review as early as possible. Whether you submit hardcopy
originals or digital artwork, you must follow the criteria (format, sizing, resolution, etc.) found in the RLPG
Artwork Guide.

e Do not incorporate artwork into your chapter files.

¢  Gather all of your figure numbers and captions and all source/credit lines in one file named “captions.doc.”
They should not appear on the artwork.

¢ Double-number your artwork so the first number is the chapter number and the second number indicates the
sequence (e.g., figure 5.1 is the first figure in chapter 5).

¢ Direct your readers to your artwork by referring to it in the text by number (e.g., “figure 5.1 shows ...” or
“see figure 5.1”).

e Place a callout for each piece of art near where you would like it to appear (e.g., <figure 5.1 near here>).

e Artwork will be placed as near its callout as the text allows, but that is not determined until typesetting, so do
not refer to artwork as being “above,” “below,” or on a specific page.
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e If you would like your book to have a list of illustrations in the front matter, you must provide one in the
manuscript.

SUBMITTING YOUR FINAL MANUSCRIPT

¢ Have you made all changes requested by your acquisitions editor? Have you checked the Author Contracts
for Typesetting Checklist?

e Have you run spell-check and proofread the final manuscript carefully? Remember, your submitted
manuscript will be considered final. Once the project is sent into production, revisions will not be accepted.
We will correct errors during proofreading.

e Have you included all necessary permissions letters for tables, art, photos, previously published materials,
quotations, etc.?

e Have you created separate files for each chapter and any other sections of your manuscript? Have you used
file names that are easily recognizable? For example, contents.doc, intro.doc, ch01.doc, biblio.doc.

e We do not need a printout of the manuscript, however, if it contains special characters (e.g., non-Latin
characters/diacritics, directional symbols, equations), alert your acquisitions editor to their presence. If you
have used a different alphabet (such as Hebrew or Cyrillic), characters (such as Chinese), or diacritical marks
in your text, please include a copy of the font file (e.g. Simsum for Chinese), in case we or the printer do not
have it.

e If you cannot supply electronic versions of your artwork, mail the originals to your acquisitions editor so they
can be scanned. They will be returned to you when your book is published.

e E-mail all of your files to your acquisitions editor, however, ask if large art files should be sent using an
alternate method (mailed on media or via FTP).
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AUTHOR CONTRACTS FOR TYPESETTING
FORMATTING CHECKLIST
ROWMAN & LITTLEFIELD PUBLISHING GROUP

Rowman & Littlefield - Lexington Books - Jason Aronson

Please follow the following guide for manuscripts being typeset by RLPG. If formatting guidelines are
not met, we will return the manuscript to the author to fix, which may delay the book’s publication date.
For more detailed guidelines, please consult the RLPG Typeset Manuscript Preparation Guide
provided with your contract.
Guidelines apply to ALL front matter, chapters, end notes, and back matter.

] 12-point, Times New Roman font

[] 1-inch margins top, bottom, left, and right

[[] Double spaced

] Opt spacing before and after each paragraph (can be changed in Format — Paragraph)

I:l Remove any bold or underlined font (use italics for emphasis, titles, etc.)

[] Textis left-justified, not fully justified

All page numbers are changed to be sequential (i.e. If Chapter 1 ends on page 38,
Chapter 2 begins on page 39)

Page numbering of front matter is in lower-case Roman numerals
Remove any line spaces between paragraphs or references

Remove superscript format from endnotes (can be changed in Format — Font), but keep
reference numbers in text body as superscript

O OO0 O

Footnotes are converted to endnotes
[[] Endnotes use Arabic numerals, not Roman numerals and are followed by a period
For figures/graphics:

D Figures and images are in eps, tiff, jpeg, or pdf format and at 300 dpi, at the size they will
gu 8 % Jpeg, or p p y
appear in the book

[[] Whenever possible, figures/graphics are black and white only, no color or grayscale (this
will come out much clearer in the book)

[C] For charts and graphs, use patterns in lieu of colors and symbols to distinguish plotted
points




O o O

[]
Submission:
[]
[]
[]

All figures/graphics are saved as separate documents with a file name indicating their
chapter/figure number (see RLPG Artwork Guide)

Tables and textboxes are saved separately in Word documents (see RLPG Tables Guide)
Callouts are correctly placed and match graphic titles

Captions and permissions are provided

Send 2 electronic files, one as a single file and one with each chapter in separate files
Send 1 hard copy, unless otherwise specified by your editor

Send all necessary consent forms and permissions (see the RLPG Permissions Guide)



TABLES GUIDE
ROWMAN & LITTLEFIELD PUBLISHING GROUP

Rowman & Littlefield - Lexington Books - Jason Aronson

Follow these instructions to create tables:

Use the Tables feature of Microsoft Word* to create all tabular matter.

The body of a table is composed of vertical columns of information. Avoid mixing different types of
information in the same column; separate money from percentages or information expressed in words. Keep
items consistent in form, as well (e.g., don’t abbreviate some state names and spell out others).

Before creating the table body, type “Table” and the table number in double-number format (e.g., Table 2.1
would be the first table in chapter 2) followed by the table title. For the title, strive for brevity and objectivity.
For example, use “Recidivism among Reform School Parolees” rather than “High Degree of Recidivism
among Reform School Parolees.”

If you have a short bit of important explanatory information (e.g., unit of measure, statistical
information), it can be included in parentheses after the table title or heading. More detailed information
should be placed in a note at the bottom of the table (see no. 7 below).

To create the table body, go to the Table menu, choose Insert, then Table. Enter the number of columns and
rows your table should have, then press OK. Columns and rows can be added later if necessary, but it’s best
to have the correct number to begin with.

Keep column headings short. If a column head or text runs to a second line, let it wrap automatically and
don’t worry about awkward word or line breaks. We will fix such problems during typesetting.

If column headings must straddle two or more columns, use the Merge feature. With the mouse, place the
cursor in the left-most cell that you want to merge, press and hold the left button of your mouse and drag the
cursor to the right until you have selected (highlighted) all of the cells you want to merge. Release the mouse
button and then go to the Table menu and select Merge Cells (or right-click and choose Merge Cells).

If footnotes are necessary, they should appear below the table. There are four different kinds of table
footnotes, and they should be placed in the following order:

Source. If the data for your table came from another source or sources, provide complete information
about the source(s). If a table is reproduced without change from another source, you must obtain permission
to reuse it (which you will need to provide to us) and supply the full credit in the source line. The source line
appears just below the table, beginning with Source: or Sources: followed by full citation.

A note applicable to the whole table. This is used for providing information about how data were
gathered, the reliability of the information, and so on. Place the information following Note or Notes.

Notes specific to a part of the table. In the table body, place a lowercase superscript letter (starting with
a) to the right of the item that the note addresses. At the bottom of the table, insert the same superscript letter
and then type the note. Do not put a note callout on the table title.

Notes on statistical significance levels/probability notes. These notes are inserted at the bottom of the
table only. Use asterisks to differentiate between levels of significance: a single asterisk is used for the lowest
level, two asterisks for the next level up, and three asterisks for the highest level of significance.

Save each table in a separate file named for the table number (e.g., the file name for table 2.1 would be
“table02-01.doc”). Do not insert your table into the chapter files. Instead, use a callout (see note 10).

"These instructions are specific to Word 2003, however most word-processing programs have similar features.
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In addition:

9. Inyour manuscript, direct your readers to your tables by referring to them by number (e.g., “table 2.1 shows .
..” or "“see table 2.1”).

10. After the paragraph in which you reference a table, insert a callout for the typesetter (e.g., <table 2.1 here>).
Tables without callouts may inadvertently be omitted from the final layout.

11. Tables will be placed as near to their callouts as text allows, but exact placement is not determined until
typesetting, so do not refer to tables and textboxes as being “above,” “below,” or on a specific page.

12. If you find your data is too wide to fit on one page, change the page setup to “landscape” (a.k.a.,
“broadside”). Go to the File menu and select Page Setup; on the Margins tab select Landscape for orientation
and then click “OK.”

If it is still too wide to fit (even when reduced to 10-point type), then it is too large for the book, and you
will need to edit it or divide it into two or more tables. The exception may be if your book will be published
in a format larger than our standard 6” x 9” trim size. Please confirm the planned dimensions for your book
with your acquisitions editor.

13. In addition to submitting the table files, you must also submit printouts of the tables that show correct
column and row alignment.

On the printouts, you may also write in symbols and formatting you were unable to accomplish
electronically.

14. For a more in-depth discussion of table creation and formatting, refer to chapter 13 of the Chicago Manual of
Style, 15th ed.

The following samples were created using the table tool in Microsoft Word. For space considerations only, we
have placed more than one table per page.

Table 1.1. Florida Drug Offenders

Arrest History
Violent Felony Crime? Nonviolent Felony Crimes
Concentration Percent Zero Concentration
Drug Offense Offenders Percent None Index® or One Indext
Possession 45,906 76.0 34.4 42.2 34.1
Sale 8,472 65.5 26.2 27.8 18.0
Smuggling 384 69.5 29.6 40.4 19.8
Production 452 86.5 41.9 63.3 23.7
Trafficking 3,308 82.6 40.3 53.3 22.0
Delivery and
distribution 1,997 69.4 28.5 31.9 204
Possession of
drug
equipment 6,256 68.2 30.1 31.0 18.8

Source: Trager and Clark (1989).

Note: Drugs addressed in study were cocaine, heroin, ecstasy, and marijuana.

#Violent crimes include homicide, sexual assaults, robbery, aggravated assault, kidnapping, and arson (zero or
one). Nonviolent offenses include burglary, larceny, automobile theft, and drug felonies.

bThe proportion of arrests in each category is accounted for by the 2.3 percent of the population that is most
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frequently arrested. These offenders exceed the mean number of arrests by two standard deviations.

Table 1.2. Leading Television Markets for Religious Programs

Eastern Core Western Core Other

Group A?®

Birmingham, AL Little Rock, AR

Charleston-Huntington, WV Tulsa, OK

Greenville-New Bern-Washington,
NC

Greenville-Spartansburg, SC-
Asheville, NC

Johnstown-Altoona, PA

Knoxville, TN

Norfolk-Portsmouth-Newport News-
Hampton, VA

Raleigh-Durham, NC

Richmond, VA

Roanoke-Lynchburg, VA

Tampa-5t. Petersburg, FL

Group B

Augusta, GA Dallas-Fort Worth, TX Mobile, AL

Charlotte, NC Kansas City, MO/KS

Chattanooga, TN Jackson, MS

Cincinnati, OH Monroe, LA-El Dorado, AR

Jacksonville, FL Wichita Falls, TX-Lawton, OK

Tallahassee, FL

Wheeling, WV-Steubenville, OH

20ver 60,000 viewing households and over 15 percent viewing rate.

®Either 60,000 viewing households and moderate (7-15 percent) viewing rate or 40,000-60,000 households and

high (over 15 percent) viewing rate.

Table 1.3. Differentiating Characteristics of the Species of the Genus Rhodobacter

Characteristic R. Capsulatus R. Sphaeroides
Cell diameter 0.5-1.2 0.7-4.0
Motility + +

Slime formation + +
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ARTWORK GUIDE
ROWMAN & LITTLEFIELD PUBLISHING GROUP

Rowman & Littlefield - Lexington Books - Jason Aronson

The majority of book projects will not have artwork. However, If your book includes artwork (e.g.,

graphs, drawings, diagrams, maps, photographs, etc.), please discuss your proposed artwork with your
editor as soon as possible, well before submitting the manuscript to production. You are responsible for
supplying your illustrations in final form by the time you deliver your final manuscript to the publisher.

We accept two kinds of artwork: digital artwork (i.e., scanned, created electronically using software, or
taken with a digital camera) and original, hardcopy artwork (i.e., “camera ready” art). Both are explained
below. To reproduce your images at the highest possible quality, we must receive artwork from you that
meets the specifications found in these guidelines. If your artwork does not meet these specifications, you
will need to revise it or find replacement images.

PERMISSIONS
If you have taken artwork from another source, you must obtain and pay for permission to reproduce
those images by the time you submit your final manuscript. You must also supply credit/source
information with your captions. Please forward all original, signed permissions to your acquisitions
editor as soon as you have them. Remember to make a copy for your records. Without permission or a
clear indication that the work is in the public domain, we will not be able to use the art.

DIGITAL ARTWORK
We will quality-check all of your digital artwork, and you will need to replace or drop from your book
any images that fail to meet our standards. If you are providing digital artwork:

¢ The minimum resolution should be 300 dpi (dots per inch) for images 4" x 7" or larger and 600 dpi for
images smaller than 4" x 7". See the Sizing Artwork section below.

e Acceptable file formats, in order of preference, are .tif, .eps, .jpg, .pdf.

¢ Unacceptable file formats: .gif, .doc, .dot, .wpd, .xls, xlt, .png, .bmp, .psd.

Specifications for Scanning Artwork
We strongly encourage you to send original artwork to us for scanning. If that is not possible, please
follow these guidelines:

e Use a middle- to high-end flatbed scanner or a drum scanner. A handheld scanner will not produce
quality scans.

e Allimages 4" x 7" or larger should be scanned at a minimum of 300 dpi; anything smaller should be
scanned at 600 dpi.

e Scan images at their actual sizes. If an image is too small to clearly see detail, then you may enlarge it
in scanning. However, this will magnify imperfections, so if the imperfections are too noticeable,
don’t use the image.

e Do not specify a line screen value.

e Save the image as a grayscale.

e If the image is being scanned from a previously printed source (e.g., book, newspaper, magazine),
then you must use the “descreening” option to remove the screen or dot (moiré) pattern.
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¢ Files must be saved in the .tif, .eps, .jpg, or .pdf format.

e If the scan is crooked or needs to be cropped, import the image into Photoshop (or an equivalent
photo editor) and straighten or crop it there or provide a printout of the image and mark how you
would like it cropped.

e If you have a color image that will be reproduced in black and white, send it to us for scanning.

ORIGINAL “CAMERA-READY” ARTWORK
Original artwork must be “camera ready” —meaning it meets the specifications below. Your art will look
the same in the book as it does in the version you submit. We are not able to make alterations to improve
the appearance of art, and art quality is not enhanced when reproduced in a book.

Photographs, Slides, Transparencies, Paintings, Drawings

e Photographs with a glossy finish are preferable, but a matte finish is acceptable.

e The more contrast a photo has, the better it will reproduce. For example, the darkest areas should be
black, not gray; the lightest areas should be pure white, not light gray; and there should be a full
range of gray shades between these extremes.

e When necessary, crop marks, horizontal or vertical orientation, enlargement of details, etc., should be
indicated on a photocopy accompanying the original.

e We can scan slides, but it is possible that when we enlarge the scan of the slide, the image may
become distorted. If less than the full image is required, we will need to see a printed copy of the
image showing cropping instructions.

e  We accept color images, but detail may be lost when we convert them to black and white. We never
reproduce artwork in color, except on front covers.

Line Art (Graphs, Charts, Maps, Diagrams)

e We prefer you to use Illustrator, Photoshop, InDesign, QuarkXpress, PageMaker, or Freehand to
create original line art. However, you may also use Microsoft Word or Excel.

e Line art should be only black and white. Do not use color when preparing line art.

e Patterns should be used to differentiate between areas such as the bars on a graph. Avoid using
grayscale (i.e., shades of gray), which causes legibility problems and creates difficulties at the printing
stage.

e Symbols should be used to distinguish plotted points on a graph.

¢ Minimum line widths/weights should be at least 1/2-point. Anything thinner will not reproduce well.

e Line art should be provided as a high-quality laser printout at a minimum resolution of 1200 dpi
(dots per inch). If the image is smaller than 4" x 7", then the minimum resolution should be 2400 dpi.

SIZING ARTWORK
We publish most of our books at a 6" x 9" trim size. For art to fit on a 6" x 9" book page, it should be no
larger than 4" x 7". However, before you finalize your art, check with your acquisitions editor about the
trim size and print area of your book.

e Any text labels in your artwork should be sized at 8-10 points, so keep that range in mind when
creating the dimensions of your artwork. If your artwork exceeds your book’s dimensions, it will be
reduced, which could cause detail or text labels to become illegible. If this happens, we will ask you
to resize the art and its text.

e We do not enlarge artwork, as it degrades image quality.

e Use only one font for all of your artwork’s labeling. It should be a sans-serif typeface, such as Arial or
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Helvetica. This style of typeface is more legible at smaller sizes than serif typefaces (e.g., Times,
Garamond) and will not “clash” with the serif typeface used for the main text.

® We cannot make editorial corrections to artwork in-house. Artwork with errors or inconsistencies will
be returned to you for correction, so make sure the artwork’s spelling, hyphenation, and
capitalization choices matches those used in the text. Our production editors and proofreaders follow
Merriam-Webster’s Collegiate Dictionary, 11th ed., and the Chicago Manual of Style, 15th ed., so if you
have any doubt on how something should look, consult these references.

® Volume editors: Please ask all of your contributors to use the same font for labeling artwork; it will
give your book a more cohesive look.

IMPORTANT NOTES

e Artwork should be complete at the time you submit the final draft of your manuscript. Prior to that
point, please submit artwork for evaluation to your acquisitions editor.

e  Double-number artwork so the first number is the chapter number and the second number indicates
its sequence (e.g., figure 3.2 is the second figure in chapter three).

e Digital files should be named using the figure number in the file name.

e Allfigure captions (including figure numbers) and their source/credit lines must be gathered together
and put in one file named “captions.doc.”

e If you would like your book to have a list of illustrations in the book’s front matter, you must include
one in your manuscript.

e Use photocopies to show where you would like art cropped.

e Do not incorporate digital artwork into the chapter files; each image must be in its own file. Digital
artwork should be supplied in its original format.

® Place a callout for each piece of art in the chapter near where you would like it to appear (e.g., <figure
3.2 near here>). Any images that do not have callouts may not be placed in the final layout.

e Artwork will be placed as near its callout as the text allows, but that is not determined until
typesetting, so do not refer to artwork as being “above,” “below,” or on a specific page.

e Label all camera-ready artwork on the back with the author name and figure number. Avoid writing
directly on original artwork as it could mar the surface.

e Do not use paperclips to attach artwork: they can scratch the images.

e Camera-ready artwork should be placed in a sturdy folder or envelope and mailed to your
acquisitions editor.

e  We prefer to receive digital artwork as uncompressed files.

® We cannot guarantee the safe return of original photographs or one-of-a-kind artwork, so instead
please supply high-quality reproductions. However, if you do supply original artwork and would
like us to return it to you, please provide a list of which pieces you would like returned and the
address to which you would like them sent. Artwork will not be returned until after the book has
been published.
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